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SYMANTEC SOFTWARE LICENSE AGREEMENT
IMPORTANT:  PLEASE READ THE TERMS AND CONDITIONS 
OF THIS LICENSE AGREEMENT CAREFULLY BEFORE USING 
THE SOFTWARE.  SYMANTEC CORPORATION AND/OR ITS 
SUBSIDIARIES (“SYMANTEC”) IS WILLING TO LICENSE THE 
SOFTWARE TO YOU AS THE INDIVIDUAL, THE COMPANY, 
OR THE LEGAL ENTITY THAT WILL BE UTILIZING THE 
SOFTWARE (REFERENCED BELOW AS “YOU” OR “YOUR”) 
ONLY ON THE CONDITION THAT YOU ACCEPT ALL OF 
THE TERMS OF THIS LICENSE AGREEMENT.  THIS IS A 
LEGAL AND ENFORCEABLE CONTRACT BETWEEN YOU 
AND SYMANTEC.  BY OPENING THIS PACKAGE, BREAKING 
THE SEAL, CLICKING ON THE “AGREE” OR “YES” BUTTON 
OR OTHERWISE INDICATING ASSENT ELECTRONICALLY, OR 
LOADING THE SOFTWARE, YOU AGREE TO THE TERMS 
AND CONDITIONS OF THIS AGREEMENT.  IF YOU DO NOT 
AGREE TO THESE TERMS AND CONDITIONS, CLICK ON 
THE “I DO NOT AGREE” OR “NO” BUTTON, OR OTHERWISE 
INDICATE REFUSAL, MAKE NO FURTHER USE OF THE 
SOFTWARE, AND RETURN THE FULL PRODUCT WITH 
PROOF OF PURCHASE TO THE DEALER FROM WHOM IT 
WAS ACQUIRED WITHIN SIXTY (60) DAYS OF PURCHASE, 
AND YOUR MONEY WILL BE REFUNDED.

1. License:

The software which accompanies this license (collectively the 
"Software") is the property of Symantec or its licensors and is 
protected by copyright law.  While Symantec continues to own 
the Software, you will have certain rights to use the Software 
after your acceptance of this license.  This license governs any 
releases, revisions, or enhancements to the Software that 
Symantec may furnish to you.  Except as may be modified by 
a Symantec license certificate, license coupon, or license key 
(each a “License Module”)  which accompanies, precedes, or 
follows this license, your rights and obligations with respect to 
the use of this Software are as follows:

You may:

A. use one copy of the Software on a single computer.  If a 
License Module accompanies, precedes, or follows this 
license, you may make that number of copies of the Software 
licensed to you by Symantec as provided in your License 
Module. Your License Module shall constitute proof of your 
right to make such copies.
B. make one copy of the Software for archival purposes, or 
copy the Software onto the hard disk of your computer and 
retain the original for archival purposes;
C. use the Software on a network, provided that you have a 
licensed copy of the Software for each computer that can 
access the Software over that network; and
D. after written notice to Symantec, transfer the Software on a 
permanent basis to another person or entity, provided that you 
retain no copies of the Software and the transferee agrees to 
the terms of this license.

You may not:

A. copy the printed documentation which accompanies the 
Software; 
B. sublicense, rent or lease any portion of the Software; 
reverse engineer, decompile, disassemble, modify, translate, 
make any attempt to discover the source code of the Software, 
or create derivative works from the Software; 
C. use a previous version or copy of the Software after you 
have received a disk replacement set or an upgraded version. 

Upon upgrading the Software, all copies of the prior version 
must be destroyed; 
D. use a later version of the Software than is provided 
herewith unless you have purchased upgrade insurance or 
have otherwise separately acquired the right to use such later 
version;
E. use, if you received the software distributed on media 
containing multiple Symantec products, any Symantec 
software on the media for which you have not received a 
permission in a License Module; or  
F. use the Software in any manner not authorized by this 
license.

2. Content Updates:

Certain Symantec software products utilize content that is 
updated from time to time (antivirus products utilize updated 
virus definitions; content filtering products utilize updated URL 
lists; firewall products utilize updated firewall rules; 
vulnerability assessment products utilize updated vulnerability 
data, etc.; collectively, these are referred to as "Content 
Updates").  You may obtain Content Updates for any period 
for which you have purchased a subscription for Content 
Updates for the Software (including any subscription included 
with your original purchase of the Software), purchased 
upgrade insurance for the Software, entered into a 
maintenance agreement that includes Content Updates, or 
otherwise separately acquired the right to obtain Content 
Updates.  This license does not otherwise permit you to obtain 
and use Content Updates.

3. Sixty Day Money Back Guarantee:

If you are the original licensee of this copy of the Software and 
are dissatisfied with it for any reason, you may return the 
complete product, together with your receipt, to Symantec or 
an authorized dealer, postage prepaid, for a full refund at any 
time during the sixty (60) day period following the delivery to 
you of the Software.

4. Limited Warranty:

Symantec warrants that the media on which the Software is 
distributed will be free from defects for a period of sixty (60) 
days from the date of delivery of the Software to you. Your 
sole remedy in the event of a breach of this warranty will be 
that Symantec will, at its option, replace any defective media 
returned to Symantec within the warranty period or refund the 
money you paid for the Software.  Symantec does not warrant 
that the Software will meet your requirements or that 
operation of the Software will be uninterrupted or that the 
Software will be error-free.
THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL 
OTHER WARRANTIES, WHETHER EXPRESS OR IMPLIED, 
INCLUDING THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE 
AND NONINFRINGEMENT OF INTELLECTUAL PROPERTY 
RIGHTS.  THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY 
FROM STATE TO STATE AND COUNTRY TO COUNTRY.

5. Disclaimer of Damages:

SOME STATES AND COUNTRIES, INCLUDING MEMBER 
COUNTRIES OF THE EUROPEAN ECONOMIC AREA, DO NOT 
ALLOW THE LIMITATION OR EXCLUSION OF LIABILITY FOR 



INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE 
BELOW LIMITATION OR EXCLUSION MAY NOT APPLY TO 
YOU.
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE 
LAW AND REGARDLESS OF WHETHER ANY REMEDY SET 
FORTH HEREIN FAILS OF ITS ESSENTIAL PURPOSE, IN NO 
EVENT WILL SYMANTEC OR ITS LICENSORS BE LIABLE TO 
YOU FOR ANY SPECIAL, CONSEQUENTIAL, INDIRECT OR 
SIMILAR DAMAGES, INCLUDING ANY LOST PROFITS OR 
LOST DATA ARISING OUT OF THE USE OR INABILITY TO 
USE THE SOFTWARE EVEN IF SYMANTEC HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
IN NO CASE SHALL SYMANTEC’S OR ITS LICENSORS’ 
LIABILITY EXCEED THE PURCHASE PRICE FOR THE 
SOFTWARE.  The disclaimers and limitations set forth above 
will apply regardless of whether you accept the Software.

6. U.S. Government Restricted Rights:

RESTRICTED RIGHTS LEGEND. All Symantec products and 
documentation are commercial in nature.  The software and 
software documentation are “Commercial Items”, as that term 
is defined in 48 C.F.R. section 2.101, consisting of “Commercial 
Computer Software” and “Commercial Computer Software 
Documentation”, as such terms are defined in 48 C.F.R. section 
252.227-7014(a)(5) and 48 C.F.R. section 252.227-7014(a)(1), 
and used in 48 C.F.R. section 12.212 and 48 C.F.R. section 
227.7202, as applicable.  Consistent with 48 C.F.R. section 
12.212, 48 C.F.R. section 252.227-7015, 48 C.F.R. section 
227.7202 through 227.7202-4, 48 C.F.R. section 52.227-14, and 
other relevant sections of the Code of Federal Regulations, as 
applicable, Symantec’s computer software and computer 
software documentation are licensed to United States 
Government end users with only those rights as granted to all 
other end users, according to the terms and conditions 
contained in this license agreement.  Manufacturer is Symantec 
Corporation, 20330 Stevens Creek Blvd., Cupertino, CA  95014.

7. General:

If You are located in North America or Latin America, this 
Agreement will be governed by the laws of the State of 
California, United States of America. Otherwise, this 
Agreement will be governed by the laws of England.  This 
Agreement and any related License Module is the entire 
agreement between You and Symantec relating to the Software 
and:  (i) supersedes all prior or contemporaneous oral or 
written communications, proposals and representations with 
respect to its subject matter; and (ii) prevails over any 
conflicting or additional terms of any quote, order, 
acknowledgment or similar communications between the 
parties.  This Agreement may only be modified by a License 
Module or by a written document which has been signed by 
both You and Symantec.  This Agreement shall terminate upon 
Your breach of any term contained herein and You shall cease 
use of and destroy all copies of the Software.  The disclaimers 
of warranties and damages and limitations on liability shall 
survive termination.  Should you have any questions 
concerning this Agreement, or if you desire to contact 
Symantec for any reason, please write: (i) Symantec Customer 
Service, 555 International Way, Springfield, OR 97477, USA, or 
(ii) Symantec Customer Service Center, PO BOX 5689, Dublin 
15, Ireland.



What to do if a virus is found

Have you installed Norton 
AntiVirus? (See page 11)

Start from the Norton AntiVirus CD and 
then install. (If you have a macro virus, 
you can still install safely.) (See page 11)

Yes No

Yes

No

Ensure automatic protection by 
updating your virus definitions regularly 
and scanning again. (See page 41)

Does your computer have 
a virus?

Has Norton AntiVirus 
Auto-Protect informed you that 
you have a virus? (See page 31)

Yes

Repair or delete the infected 
file. (See page 32)
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C H A P T E R
Installing 
Norton AntiVirus

Welcome to Norton AntiVirus for Macintosh
Norton AntiVirus provides comprehensive virus prevention, detection, and 
elimination software for your Macintosh computer. As the world's leading 
antivirus software for Macintosh systems, it finds and repairs infected files 
to keep your data safe and secure. Easy updating of virus definitions over 
the Internet keeps Norton AntiVirus prepared for the latest threats. 

What is a virus?
A computer virus is a parasitic program written by an ill-intentioned 
programmer. Viruses are spread through disks, local networks, and the 
Internet. Computer viruses attach to programs.

Some viruses, such as macro viruses, spread via Microsoft Office files and 
can be transferred between PCs and Macintosh computers. Macro viruses 
are not known to damage Macintosh operating systems or hardware, but 
they can damage Microsoft Office data files and spread whenever you 
open an infected file. 

What are virus definitions?
Virus definitions are files that contain virus footprints that let 
Norton AntiVirus recognize viruses and intercept their activity. You can 
look up virus names in Norton AntiVirus, and access an encyclopedia of 
virus descriptions on the Symantec Web site. For more information, see 
“Looking up virus names and definitions” on page 27.
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Installing Norton AntiVirus 
Is my computer protected now?
When you have installed Norton AntiVirus using Easy Install, you have 
complete virus protection. However, new viruses are created constantly. 
Symantec must create a virus definition for each newly discovered virus, 
and you must update virus definitions regularly to stay protected. See 
“Keeping current with LiveUpdate” on page 37 for more information.

Tips for avoiding viruses
Viruses can spread when you start your computer from an infected disk or 
when you run an infected program.

To avoid viruses:

■ Use LiveUpdate regularly to update your program and virus definitions 
files. For more information, see “Keeping current with LiveUpdate” on 
page 37.

■ Create a SafeZone for the folder to which you download files. This 
ensures that Auto-Protect scans all downloaded files. For information 
about SafeZones, see “What part of my computer is protected?” on 
page 20.

■ Keep Norton AntiVirus Auto-Protect turned on at all times to prevent 
viruses from infecting your computer. If Norton AntiVirus Auto-Protect 
is not turned on, scan disks before you use them.

■ Back up files regularly and keep more than just the most recent 
backup. Also, make a backup copy of your uninfected System Folder.

■ Write-protect removable media.

■ Schedule scans to occur automatically. For more information, see 
“Scheduling a scan event” on page 25.

■ Stay informed about viruses by logging on to the Symantec Web site 
(securityresponse.symantec.com) where there is extensive, frequently 
updated information on viruses and virus protection.

About your Norton AntiVirus for Macintosh CD
Use your Norton AntiVirus for Macintosh CD to install your software. The 
CD contains installation instructions for Mac OS 9 and Mac OS X. 
Double-click the OS 9 folder to install for Mac OS 8.1-9.x.
10



Installing Norton AntiVirus for Macintosh
In addition to the Norton AntiVirus for Macintosh Installer, other items are 
also included on the CD. These items include:

■ New Info: Contains late breaking information, troubleshooting tips, 
installation instructions, and the default location of all files installed by 
Norton AntiVirus.

■ SimpleText application: Lets you read the New Info file.

Installing Norton AntiVirus for Macintosh
For late breaking information and installation troubleshooting tips, see the 
New Info file on the CD. Insert the CD into your CD-ROM drive and 
double-click the New Info file.

Old Norton AntiVirus for Macintosh and Symantec AntiVirus for Macintosh 
(SAM) files are deleted when you install Norton AntiVirus to the same 
location. If they are in a different location, delete them.

 To install Norton AntiVirus for Macintosh:

1 Insert the Norton AntiVirus for Macintosh CD into the CD-ROM drive.

If the CD window doesn’t open automatically, double-click the CD 
icon to open it.

2 In the CD window, double-click Install for OS 9. 

3 In the Install for OS 9 window, double-click Norton AntiVirus Installer.

4 Follow the prompts to progress through the information screens. If you 
click Disagree on the License and Warranty Agreement, the installation 
is cancelled.

5 Do one of the following:

■ For a full installation, click Easy Install.

■ To select individual components, click Custom Install, and select 
the components to install.

6 Confirm or specify a destination folder to which to install.

7 Read the subscription notice and click OK.

8 Select or confirm the Virus Scanning Preferences and click OK.

You can change these preferences at any time after you install. For 
more information, see “Selecting a virus protection level during 
installation” on page 12.
11



Installing Norton AntiVirus 
9 Follow the on-screen instructions to complete the installation, and then 
click Restart.

After you restart, if you have trouble ejecting the CD, try one of the 
following:

■ Press the CD-ROM drive’s eject button when your Macintosh restart 
chime sounds.

■ On newer Macintosh computers with a slot-loading CD-ROM drive, 
press the mouse button while starting up to eject the CD.

When you install Norton AntiVirus with the Standard Protection, you are 
protected from most viruses after you restart. With this level of protection, 
Norton AntiVirus Auto-Protect loads when you restart and actively protects 
your computer unless you turn Auto-Protect off.

Note: If you experience problems with library files immediately after 
installing, you might still have incompatible files from a previous version of 
Norton AntiVirus for Macintosh. In your System Folder, delete the Norton 
AntiVirus Additions folder from the Extensions folder and reinstall Norton 
AntiVirus.

Selecting a virus protection level during installation

During the Norton AntiVirus for Macintosh installation process, you can 
select a level of virus protection that matches your computing needs. These 
levels are combinations of more detailed custom preferences.
12



Installing Norton AntiVirus for Macintosh
Choose from the following protection levels:

■ No Protection: Auto-Protect is turned off. You have no automatic virus 
protection with this setting. You can scan for viruses manually, use the 
contextual menu to scan selected items, or use the Control Strip feature 
to turn Auto-Protect on.

■ Minimal Protection: Auto-Protect is turned on, but only to scan files 
that are being opened or created, and Internet file downloads. 

■ Standard Protection: This setting monitors Internet activity, 
installations, and file exchanges, and provides warnings of common 
virus-like activities.

■ Full Protection: With this setting, all of your computing activities are 
monitored for virus activities. If you use File Sharing on your 
computer, or your computer is exposed to viruses, use this setting.

The Compression Scanning options let you select the types of compressed 
files Norton AntiVirus will scan. Because compressed files take longer to 
scan, you might want to adjust these settings.

To change settings later, see “Setting general and custom preferences” on 
page 20.

About your virus subscription

Norton AntiVirus includes a one-year subscription to virus definitions. 
Updates are made available monthly, or more frequently when necessary. 

You can obtain regular virus definitions updates manually or on a 
customized schedule using LiveUpdate. 

For more information, see “About LiveUpdate” on page 37.
13



Installing Norton AntiVirus 
What to do after installing
When you restart your computer after installing Norton AntiVirus with 
Standard protection, Auto-Protect loads into memory, providing constant 
protection to your computer, including hard disk, memory, and downloads 
from the Internet or email.

Update your virus definitions. See “About LiveUpdate” on page 37.

Scan your hard disk using the latest virus definitions to make sure there are 
no recent viruses. See “Scanning for viruses” on page 21.

For more information
Context-sensitive help is built in to the Norton AntiVirus for Macintosh 
application. Norton AntiVirus for Macintosh Guide help files contain 
information about how to use Norton AntiVirus features. 

 To access Help: 

■ Click the Guide on the Help menu in any window in Norton AntiVirus.

Norton AntiVirus Balloon Help contains explanations of items on the 
screen. 

 To turn on Balloon Help:

■ On the Help Menu, click Show Balloons; point to any item to see a 
description.

Note: The New Info file on the Norton AntiVirus for Macintosh CD 
contains information that was unavailable at the time this guide was 
published. Read this information before you go any further.

Accessing context-sensitive help
Norton AntiVirus for Macintosh Help is an interactive guide that walks you 
through unfamiliar tasks.
14



Registering Norton AntiVirus for Macintosh
Norton AntiVirus for Macintosh Help and Shortcuts include:

■ Step-by-step guidelines to Norton AntiVirus for Macintosh procedures

■ Definitions of terms related to Norton AntiVirus for Macintosh and your 
computer

■ Tips and shortcuts to make Norton AntiVirus for Macintosh 
applications faster and easier to use

 To open Norton AntiVirus for Macintosh Help:

1 Start Norton AntiVirus for Macintosh.

2 On the Help menu, click Norton AntiVirus for Macintosh Help.

3 Click a help book on the left and a topic on the right.

4 Click OK.

 To turn on Balloon Help:

■ On the Help menu, click Show Balloons.

Registering Norton AntiVirus for Macintosh
Using your existing Internet connection, you can register Norton AntiVirus 
for Macintosh via the Internet (the global network of computers).

If you are running Macintosh OS 8.5 or later, an icon in the 
Norton AntiVirus for Macintosh folder lets you launch your browser and 
connect to the Symantec software registration page. If you are running an 
earlier version of Macintosh OS, point your browser to the Symantec Web 
page.

 To register via the Internet:

1 Connect to the Internet.

If you use America Online (AOL) to connect to the Internet, see “To 
register your software via AOL:” on page 17.

2 In the Norton AntiVirus for Macintosh folder, double-click Register 
Your Software.

Your default Internet browser displays the Symantec Service & Support 
registration page.
15



Installing Norton AntiVirus 
3 If you are using Macintosh OS 8.1, start your browser and navigate to 
the Symantec Service & Support page:

www.symantec.com/custserv/cs_register.html

4 On the support page, click I am a home/small business user.

5 On the next support page, select the product Norton AntiVirus for 
Macintosh and your version.

6 Click continue.

7 On the Norton AntiVirus for Macintosh registration page, type all of the 
required information.

8 Click Submit Registration.

Reading Late Breaking News

Norton AntiVirus for Macintosh installs a Late Breaking News link. Use this 
link to get the latest information available for your installed software.
16



Registering Norton AntiVirus for Macintosh
 To read Late Breaking News:

1 Connect to the Internet.

If you use America Online (AOL) to connect to the Internet, see “To 
read Late Breaking News via AOL:” on page 18.

2 In the Norton AntiVirus for Macintosh folder, double-click Late 
Breaking News.

Your default Internet browser displays the Symantec Late Breaking 
News Web page for your product.

3 If you are using Macintosh OS 8.1, start your browser and navigate to 
the Symantec Web page:

http://www.symantec.com/product/home-mac.html

Connecting to the Symantec Web site through America Online

If you use America Online (AOL) as your Internet Service Provider (ISP), 
you must connect to AOL before you go to the Symantec software 
registration page or view the Late Breaking News.

 To register your software via AOL:

1 Log on to AOL.

2 On the AOL Welcome page, click the AOL Internet browser.

3 Move the AOL browser and any other open AOL windows out of the 
way. 

4 In the Norton AntiVirus window, double-click Register Your Software.

5 On the support page, click I am a home/small business user.

6 On the next support page, select the product Norton AntiVirus for 
Macintosh and your version.

7 Click continue.

8 On the Service & Support page, type all of the required information.

9 Click Submit Registration.

10 Disconnect from AOL.
17



Installing Norton AntiVirus 
 To read Late Breaking News via AOL:

1 Log on to AOL.

2 On the AOL Welcome page, click the AOL Internet browser.

3 Move the AOL browser and any other open AOL windows out of the 
way. 

4 In the Norton AntiVirus for Macintosh folder, double-click Late 
Breaking News.

Your browser displays the Symantec Late Breaking News Web page for 
your product.

5 When you have finished reading, disconnect from AOL.
18



C H A P T E R
Protecting disks, files, 
and data from viruses

About automatic protection
You don’t need to run Norton AntiVirus regularly as long as Auto-Protect is 
active. Auto-Protect interception prevents viruses from moving to your 
drive, and you can use the contextual menu to scan a specific volume, file, 
or folder. However, you do need to start the Norton AntiVirus application 
to set up a schedule for scanning or to change the preferences that were 
set during installation.

About Norton AntiVirus Auto-Protect

Norton AntiVirus Auto-Protect works independently of the Norton 
AntiVirus application. It loads on startup and alerts you if a virus is 
detected while you’re working.
19



Protecting disks, files, and data from viruses 
What part of my computer is protected?

Auto-Protect detects viruses within the SafeZones you choose in the 
General and SafeZone Preferences. Within designated SafeZones, 
Auto-Protect performs a virus scan on any file that is changed or created, 
any file that is opened or launched, and any disks that are inserted. You 
can see and change what is protected, and where the SafeZones are 
through the general or custom preferences.

Turning Auto-Protect on or off with the Control Strip

Norton AntiVirus installs a Control Strip module so that you can turn 
Auto-Protect on or off without opening the Control Panel or the Norton 
AntiVirus application.

You must have the Control Strip Control Panel enabled. 

 To enable the Control Strip:

1 Click Control Panels.

2 Click Control Strip. 

3 Make sure that Show Control Strip is selected, or that a Show/Hide 
Control Strip hot key is defined.

 To turn Auto-Protect on or off from the Control Strip:

1 Click the Control Strip.

2 Click the Auto-Protect Control Strip module.

3 On the popup menu, do one of the following:

■ Click Auto-Protect On.

■ Click Auto-Protect Off.

Setting general and custom preferences
You can change the general settings that were set up when you installed 
Norton AntiVirus for Macintosh. 

Auto-Protect 
Control Strip icon

Turn 
Auto-Protect 
on or off
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Scanning for viruses
 To set Norton AntiVirus preferences:

1 On the Preferences menu, click General Preferences.

2 Click a setting. 

3 To customize settings, click Custom.

4 Click an icon on the left to see the corresponding preferences.

Custom preferences take precedence over any protection level set in 
General preferences.

Scanning for viruses
When you install Norton AntiVirus, scan your hard disk as soon as you 
update your virus definitions. Perform full scans at regular intervals. This 
ensures that no undetected viruses have been transferred onto your hard 
disk.

Open Custom 
preferences

General 
Preferences

Click to view 
Apple Guide 
descriptions 

Open General 
preferences

Click to view 
Apple Guide 
descriptions 

Custom 
Preferences

Select different 
groups of 
preferences
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Protecting disks, files, and data from viruses 
Performing full scans is especially important if you do not have your 
automatic protection level set to Full Protection.

To have Norton AntiVirus scan a specific file, folder, or disk, drag its icon 
to the Norton AntiVirus program icon. 

 To start Norton AntiVirus and scan for viruses:

1 In the Norton AntiVirus folder, double-click Norton AntiVirus.

2 In the Norton AntiVirus main window, click a disk icon, folder, or file 
to scan.

3 Click Scan or Scan/Repair.

In the Finder, you can also use the contextual menu. For more 
information, see “Using contextual menus to scan” on page 23.

Item at the root 
of the currently 
displayed list of 
items

Scan/repair 
selected items

View or change 
preferences

Open Help

Get latest virus 
updates

View by file or 
volume

View scan history

Move selected 
file to Trash
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Scanning for viruses
If a virus is found during the scan, Norton AntiVirus informs you. 

4 Click Done.

If Norton AntiVirus is configured to repair infected files automatically, the 
window informs you of this action. If it is not configured to repair 
automatically, or if it is a virus that Norton AntiVirus can’t repair, you can 
take further action at the end of the scan. For details, see “If a virus is 
found while scanning” on page 32.

 To exit Norton AntiVirus:

■ On the File menu, click Quit or press Command-Q.

Using contextual menus to scan

You can use the Macintosh OS contextual menu to scan a disk or item 
without starting Norton AntiVirus.

Contextual menu 
lets you scan for 
viruses without 
starting Norton 
AntiVirus
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Protecting disks, files, and data from viruses 
 To use the contextual menu:

1 Press the Command key and click a disk, folder, or file icon, or 
anywhere on the Desktop.

2 On the contextual menu, click Norton Menu > Virus Scan/Repair.

3 The Small Scanner scans the selected item.

4 If you need to repair a virus, click Launch NAV to run the Norton 
AntiVirus main application.

Scanning email attachments

During installation, Norton AntiVirus searches for email client programs 
and identifies folders in which email attachments are saved. Norton 
AntiVirus adds these folders to its SafeZone list when any level of 
protection is active. All files that are saved in the email attachment folder 
are scanned automatically.

When checked, 
Norton AntiVirus 
scans email 
attachments 
automatically
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Scheduling automatic virus scans
Scheduling automatic virus scans
To make virus prevention as easy as possible, Norton AntiVirus lets you 
schedule the following activities:

■ Virus scans to occur at specified times. See “Scheduling a scan event” 
on page 25.

■ Automatic updates of virus definitions with LiveUpdate. See “About 
LiveUpdate” on page 37.

If your computer is turned off during the time an event should take place, 
the event occurs the next time you start your computer.

For the best protection, schedule a LiveUpdate event to update your virus 
definitions, and then schedule a scan at a time after the latest virus 
definitions have been downloaded.

Scheduling a scan event

Follow the procedure below to schedule automatic virus scans.

Dates for the 
event you are 
scheduling are 
highlighted

Click to see 
previous month

Click to see a 
list of scheduled 
events

Describes the 
selected 
scheduled 
event

Create a new 
scheduled event

Dates for previously 
scheduled events 
are underlined

Delete a 
scheduled event
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Protecting disks, files, and data from viruses 
 To schedule virus scans:

1 On the Tools menu, click Scheduler.

2 Click New.

A dialog box appears prompting you to type a name for the scheduled 
event.

3 Type the event name. 

4 Click OK.

5 In the Event Type list, specify the item to scan.

6 In the When To Do list, specify when the scan should occur.

7 In the How Often list, specify the frequency of the scan.

The days on which the scans will occur are highlighted in the calendar.

8 In the Starting date and time text boxes, select the correct time and 
date information.

The Minute option is dimmed if the scan occurs at startup or 
shutdown.

9 Click Done.

To schedule virus definitions and program updates, use the LiveUpdate 
Scheduler. For more information, see “About LiveUpdate” on page 37.

Editing and deleting scheduled events

You can make changes to events that you schedule. For a description of 
the scheduling options, see “Scheduling automatic virus scans” on page 25.

 To edit a scheduled event:

1 On the Tools menu, click Scheduler.

2 In the Event list, click the scheduled event to change.

3 Make your changes by selecting different schedule options.

4 To change the event name, click Rename and type a new name.

5 Click Done.
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Looking up virus names and definitions
 To delete a scheduled event:

1 On the Tools menu, click Scheduler.

2 In the Event list, click the scheduled event to delete.

3 Click Delete.

4 Click OK.

5 Click Done.

Looking up virus names and definitions
You can look up a virus name from within the Norton AntiVirus 
application. The Virus Definitions Info dialog box lists all of the viruses in 
the current virus definitions file. You can export this list to print it in your 
word processing program. 

To make sure that you have the latest virus definitions, run LiveUpdate. For 
more information, see “Keeping current with LiveUpdate” on page 37.

 To view virus names:

1 On the Tools menu, click View Virus Definitions Info.

2 In the Virus Definitions Info dialog box, do one of the following:

■ Click Export to export the virus list to a text file, and specify where 
to save the file. Open the exported text file in a word processing 
program to print it.

■ Click Search to search for a specific virus name. In the Virus Name 
Contains field, type the name or part of the name and click Find.
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Protecting disks, files, and data from viruses 
Because of the large number of viruses, the Virus Definitions Info file does 
not include descriptions of each virus. The Symantec Security Response 
Web site contains a list of all known viruses and related malicious code, 
along with descriptions.

Looking up virus definitions on the Symantec Web site

You can view descriptions of different Macintosh system viruses in the 
Virus Encyclopedia on the Symantec Security Response Web site.

 To view the latest virus descriptions:

1 Point your browser to the following Web site:

securityresponse.symantec.com

2 Click the link to the Virus Encyclopedia.

3 Type a virus name to search for, or scroll through the alphabetical list 
to locate a virus.

4 Click a virus to read its description.

Fine-tuning Auto-Protect performance 

If you choose the highest level of automatic protection, you might notice 
that your computer’s performance is affected during some activities. 

If you have Norton Utilities for Macintosh installed on your system, the 
FileSaver Control Panel, combined with Norton AntiVirus Auto-Protect, 
generate activities that might cause performance impairment if you have 
set maximum protection for each program. Both FileSaver and Auto-Protect 
scan your disk and keep track of current and deleted files.

You have a variety of options for fine-tuning the protection activity. Before 
making adjustments, try to determine the activity that seems to cause 
performance impairment, and make adjustments related to that activity.

If you notice a decrease in your computer’s performance, lower the levels 
of protection for Auto-Protect, and the level of scanning for FileSaver. 
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Looking up virus names and definitions
 To minimize protection levels in Norton AntiVirus:

■ In the General Preferences dialog box, lower the protection level by 
doing the following:

■ Under Automatic protection level, click Minimal Protection or No 
Protection. 

■ Under Scanning level for compressed files, click Do not scan 
compressed files.

■ In the Custom Preferences dialog box, lower the protection level in 
each area by doing the following:

■ Prevention preferences: Turn off the setting that monitors virus-like 
activities.

■ Scan preferences: Turn off automatic scanning of files when 
opened and programs when launched.

■ Compression preferences: Limit the number of file types that are 
scanned.

■ SafeZones: Limit the number of SafeZones by clicking Disable 
SafeZones, or click Custom and limit the selected SafeZones 
protected by Auto-Protect.

 To minimize protection levels in FileSaver:

1 In the FileSaver control panel, for the selected disks, uncheck settings 
for Track Deleted Files/Folders.

2 On the Update Schedule tab, minimize the frequency of updates.
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C H A P T E R
Responding to virus 
alerts

About virus alerts
Auto-Protect alerts you to virus and virus-like activity, whether the infected 
file is repaired automatically or not. If you have a higher level of 
protection, you might receive a higher number of alerts. 

For information on minimizing the number of alerts, see “Setting general 
and custom preferences” on page 20.

When Auto-Protect finds a virus

If Auto-Protect finds a virus but does not (or cannot) repair it

Look for words that identify the type of problem. Read the entire message.

Repairing the infected file is always the best choice. It eliminates the virus 
and repairs the infected item automatically.
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Responding to virus alerts 
If Auto-Protect finds a virus and repairs it

When Norton AntiVirus Auto-Protect reports that it repaired an infected 
file, you don’t have to do anything. 

A message informs you when an infected file is repaired.

Even when Auto-Protect has repaired the infected file, ensure that no other 
viruses exist on your computer by running Norton AntiVirus.

If a floppy is infected and ejected

When Standard Protection is set, Auto-Protect will eject infected floppy 
disks. You can bypass this setting by holding down the Shift key while 
inserting the floppy disk.

If you want to repair the infected floppy disk, use Norton AntiVirus to scan 
and repair it.

 To repair an infected floppy disk:

1 Start Norton AntiVirus.

2 Insert the floppy disk while holding down the Shift key on your 
keyboard. 

3 In the Norton AntiVirus main window, select the floppy disk to scan.

4 Click Scan or Scan/Repair, and follow the instructions for “If a virus is 
found while scanning” on page 32.

If a virus is found while scanning
If you are scanning with Norton AntiVirus and a virus is found, Norton 
AntiVirus repairs it, unless you changed the default settings. If an infected 
file is discovered, the file is listed as infected in the scan window.
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If Norton AntiVirus can’t repair a file
 If an infected file appears in the scan window:

1 Click the infected file in the scan results window.

2 Click the triangle to the left of the file to view more information about 
the file.

The status will be Repaired or Not Repaired.

3 If a selected file can’t be repaired, click Delete.

If Norton AntiVirus can’t repair a file
Sometimes viruses damage files beyond repair. If Norton AntiVirus finds an 
irreparably damaged file, you must delete the infected file and replace it 
with an uninfected backup copy. 

Make sure that you have scanned with the latest virus definitions. If you 
are not sure that you have the latest virus definitions, use LiveUpdate. (See 
“Keeping current with LiveUpdate” on page 37 for details.)

 To delete an infected file:

1 Run Norton AntiVirus and scan the infected file.

In the scan window, the file will indicate that it is Repaired or Not 
Repaired.

2 In the scan window, click the infected file. 

3 Click Repair. 
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Responding to virus alerts 
4 If a file can’t be repaired, click Delete.

5 Click OK.

The Status column shows that the file is Deleted.

If a Virus-like Activity alert appears

A Virus-like Activity alert is a warning and does not necessarily mean that 
your computer has a virus. You can decide whether the operation is valid, 
for example, when you are installing software or decompressing a 
compressed archive.

You can set the types of virus-like activities checked.

 To respond to a Virus-like Activity alert:

1 Do one of the following:

■ Click Remember if you don’t want the alert to appear when this 
activity occurs again.

■ Click Allow if the message describes a valid activity for the 
application you are running. 

For example, if you are changing a system setting, or making a 
copy of an application or system file, you can let the activity 
continue.

■ Click Deny if the detected activity isn’t related to what you are 
trying to do.

Depending on the activity, Auto-Protect displays different responses.

2 Press Return to choose the recommended action for the situation.
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If Norton AntiVirus can’t repair a file
See the Prevention Preferences to specify the Virus-like Activities that are 
monitored.

Select a 
monitoring level 
for Virus-like 
Activities
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A P P E N D I X
Keeping current with 
LiveUpdate

LiveUpdate can be used to keep your virus definitions files and program 
files updated. If you have an Internet connection, LiveUpdate is the most 
efficient method to update your files.

If you use America Online (AOL) as your Internet Service Provider (ISP), 
you must log on to AOL before you use LiveUpdate. For more information, 
see “Using LiveUpdate with America Online” on page 45.

About LiveUpdate
Symantec provides online access to updated program files with your 
subscription. 

Using your existing Internet connection, LiveUpdate connects to the 
Symantec LiveUpdate server, checks for available program updates, then 
downloads and installs them. 

If you have Norton AntiVirus for Macintosh installed, LiveUpdate also 
updates virus definitions files and Norton AntiVirus program files, as well 
as its own program files.

How to update virus protection

Use LiveUpdate to download and install the latest virus definitions and 
program update files with your subscription.

Virus definitions files are also available on the Symantec Web server, at the 
Symantec Web site:

www.symantec.com
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Keeping current with LiveUpdate 
For information about downloading files from the Symantec Web site, see 
“If you can’t use LiveUpdate” on page 43.

When to update virus protection

Run LiveUpdate as soon as you have installed Norton AntiVirus. Once you 
know that your virus definitions and program files are completely 
up-to-date, run LiveUpdate at least once a month.

New virus definitions files are made available monthly with your 
subscription. You can run LiveUpdate manually, or use the LiveUpdate 
scheduler. For more information, see “Scheduling LiveUpdate” on page 41.

Updating virus protection and program files
You can have LiveUpdate look for updates to all files at once, customize 
your update selection, or schedule a future LiveUpdate session.

LiveUpdate downloads and installs the available updates. A status dialog 
box keeps you informed of the file transfer process.

Select items to 
update during this 
session

Updates all 
installed 

Lets you schedule 
specific updates

Indicates the last 
update activity

Lets you schedule 
specific updates

Click to skip the 
currently 
downloading item
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Updating virus protection and program files
The file transfer takes a few minutes. When the file transfer is complete, 
LiveUpdate notifies you. 

If your files are up-to-date, LiveUpdate informs you.

 To update virus definitions and program files with LiveUpdate:

1 In the Norton AntiVirus folder, click LiveUpdate.

2 Do one of the following:

■ To update all files, click Update Everything Now.

■ To specify what to update during the current session, click 
Customize This Update Session. 

For more information, see “To customize a LiveUpdate session:” on 
page 41.

■ To open the LiveUpdate Scheduler and schedule LiveUpdate 
events, click Schedule Future Updates. 

For more information, see “To schedule a LiveUpdate event:” on 
page 42.

3 Click Close.

4 If LiveUpdate tells you that you need to restart your computer, click 
Restart.

5 On the File menu, click Quit.

List of products 
updated in this 
session

LiveUpdate 
gives a 
summary of 
its activity
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Keeping current with LiveUpdate 
Emptying the Trash after a LiveUpdate session

After you update program files with LiveUpdate, there are items in the 
Trash. LiveUpdate moves the older discarded files to the Trash. Empty the 
Trash. If you haven’t already restarted after installing the application, you 
might get a message that these files are in use. After you restart your 
computer, you can empty the Trash.

Reading the LiveUpdate What’s New file

LiveUpdate places a What’s New file on the Desktop. This contains details 
of what files were updated by LiveUpdate.

 To read the What’s New file:

■ Double-click the file to read about the contents of the updated files.

The file opens in SimpleText.

 To close the What’s New file: 

■ Press Command-Q to quit SimpleText.

 To delete the What’s New file: 

■ Drag it to the Trash.

Checking version numbers and dates

LiveUpdate lets you know if your program files and virus definitions are 
up-to-date by displaying the version numbers and the status. The Norton 
AntiVirus main window displays the date of the most recently installed 
product. You can also check the program file and virus definitions in the 
application’s About box, accessible from the Apple menu.

 To view an application’s About box:

1 Start Norton AntiVirus.

2 On the Apple menu, click About Norton AntiVirus.

The About box lists version number and copyright dates.

3 When you’ve finished viewing the About box, click OK.
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Customizing a LiveUpdate session
Customizing a LiveUpdate session
LiveUpdate lets you update only one or two items and omit the items you 
don’t want to update. 

 To customize a LiveUpdate session:

1 In the LiveUpdate window, click Customize This Update Session.

LiveUpdate scans your disk to see what applications are installed, and 
presents a list of available updates.

2 Check items to update in this session.

LiveUpdate will not look for items that are unchecked. If your files are 
already up-to-date, no items are selectable.

3 Click Update.

The file transfer takes a few minutes. When file transfer is complete, 
LiveUpdate notifies you. 

If your files are up-to-date, LiveUpdate informs you.

Scheduling LiveUpdate
You can schedule automatic LiveUpdate sessions to update program files 
and virus protection. Using the LiveUpdate Scheduler, you can set up 
events to run automatically. 

Before scheduling automatic virus protection updates, make sure the 
update process works correctly by stepping through the process manually. 
See “How to update virus protection” on page 37 for instructions.

Select items to 
update during the 
current session
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Keeping current with LiveUpdate 
 To schedule a LiveUpdate event:

1 In the LiveUpdate main window, click Schedule Future Updates.

2 In the LiveUpdate Scheduler dialog box, click New. 

3 Type the event name.

4 Click OK.

5 Specify the Event Type, How Often, and the Start Time of updates.

Updated virus definitions files are posted on the Symantec LiveUpdate 
server and Web site around the first of every month, or more 
frequently when necessary.

The days on which updates occur are highlighted in the calendar. 
Dates for other scheduled events are underlined.

Select an 
event name

Select an event 
type, time, and 
frequency

Add a new event
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If you can’t use LiveUpdate
6 Finish scheduling the update by typing the schedule time and date.

■ Click the Hour text box and use the arrow keys to set the start hour.

■ Click the Minute text box to set the start minute.

Your computer must be turned on for LiveUpdate to run at the 
scheduled time. If your computer is not on at the scheduled time, 
LiveUpdate starts the next time you start your computer.

7 Click Done.

If you can’t use LiveUpdate
When new updates become available, Symantec posts them on the 
Symantec Web site. If you can’t run LiveUpdate, you can download new 
update files from the Symantec Web site.

 To download virus definitions from the Symantec Web site:

1 In an Internet browser, go to the following site:
securityresponse.symantec.com/avcenter/defs.download.html
If this page doesn’t load, go to securityresponse.symantec.com and 
click the Download Virus Definitions link, then click the Download 
Virus Definitions (Intelligent Updater Only) link.

2 On the Download Virus Definitions page, click Norton AntiVirus for 
Macintosh.

3 Click Download Updates.

4 On the Download Updates page, select the file to download.
Be sure to select files for the appropriate version of your product. 
Information about the update is included with the download.

 To download product updates from the Symantec Web site:

1 In an Internet browser, go to the following site:
securityresponse.symantec.com/downloads/
If this page doesn’t load, go to securityresponse.symantec.com and 
click downloads.

2 On the downloads page, in the product updates list, select the product 
for which you want an update.

3 Click Browse.

4 On the product page, select the version of the product.
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Keeping current with LiveUpdate 
5 Click Continue.

6 On the updates page, select the file to download.
Information about the update is included with the download.

Deleting the NAV™ 7.0 QuickScan file
Because of the way Norton AntiVirus tracks scanned files, a new virus 
already present on your hard drive could go undetected when you first 
update definitions—even though those definitions would detect any new 
files with that virus.

If you have scanned your hard disk and found no viruses, and then you 
download new virus definitions, you might want to ensure that any 
previously undetected viruses will be found by the new definitions. 

You can use Norton AntiVirus to delete the file at the root of each drive 
called NAV™ 7.0 QuickScan. 

 To remove the QuickScan file:

1 In the Norton AntiVirus window, click the File View tab.

2 In the File View list, double-click your hard disk and locate the NAV™ 
7.0 QuickScan file. 

Ensure that Show Invisible Files is checked. 
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Using LiveUpdate with America Online
3 Click the NAV™ 7.0 QuickScan file. 

If there are other QuickScan files left over from previous versions of 
Norton AntiVirus, select them as well.

4 Click Move To Trash.

5 Click OK.

6 Click anywhere on your Desktop. 

7 On the Special menu, click Empty Trash.

After deleting this file, the first scan with the new virus definitions will 
be slower, but will detect any previously undetected viruses.

Using LiveUpdate with America Online
If you use America Online (AOL) as your Internet Service Provider (ISP), 
you might need to log on to AOL before you use LiveUpdate.

 To use LiveUpdate with AOL:

1 Log on to AOL.

2 On the AOL Welcome page, click the AOL Internet browser.

3 Start LiveUpdate.

4 Follow the procedure from “To update virus definitions and program 
files with LiveUpdate:” on page 39.

5 When the LiveUpdate session is complete, quit AOL.

If your LiveUpdate session requires that you restart your computer, 
disconnect from AOL before restarting.
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S U P P O R T
Service and support solutions

The Service & Support Web site at http://service.symantec.com supports 
Symantec products. Customer Service helps with nontechnical issues such 
as orders, upgrades, replacements, and rebates. Technical Support helps 
with technical issues such as installing, configuring, or troubleshooting 
Symantec products.

Methods of technical support and customer service can vary by region. For 
information on support offerings in your region, check the appropriate 
Web site listed in the sections that follow.

If you received this product when you purchased your computer, your 
computer manufacturer may be responsible for providing your support.

Customer service
The Service & Support Web site at http://service.symantec.com tells how 
to:

■ Subscribe to Symantec newsletters.

■ Locate resellers and consultants in your area.

■ Replace defective CD-ROMs and manuals.

■ Update your product registration.

■ Find out about orders, returns, or a rebate status.

■ Access Customer Service FAQs.

■ Post a question to a Customer Service representative.

■ Obtain product information, literature, or trialware.

For upgrade orders, visit the Symantec store at: 
http://www.symantecstore.com
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Technical support
Symantec offers two technical support options for help with installing, 
configuring, or troubleshooting Symantec products:

■ Online Service and Support
Connect to the Symantec Service & Support Web site at
http://service.symantec.com, select your user type, and then select 
your product and version. You can access hot topics, Knowledge Base 
articles, tutorials, contact options, and more. You can also post a 
question to an online Technical Support representative.

■ PriorityCare telephone support
This fee-based (in most areas) telephone support is available to all 
registered customers. Find the phone number for your product at the 
Service & Support Web site. You’ll be led through the online options 
first, and then to the telephone contact options.

Support for old and discontinued versions

When Symantec announces that a product will no longer be marketed or 
sold, telephone support is discontinued 60 days later. Technical 
information may still be available through the Service & Support Web site 
at:
http://service.symantec.com

Subscription policy
If your Symantec product includes virus, firewall, or Web content 
protection, you may be entitled to receive updates via LiveUpdate. 
Subscription length varies by Symantec product.

After your initial subscription ends, you must renew it before you can 
update your virus, firewall, or Web content protection. Without these 
updates, you will be vulnerable to attacks.

When you run LiveUpdate near the end of your subscription period, you 
are prompted to subscribe for a nominal charge. Simply follow the 
instructions on the screen. 
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Worldwide service and support
Worldwide service and support
Technical support and customer service solutions vary by country. For 
Symantec and International Partner locations outside of the United States, 
contact one of the service and support offices listed below, or connect to 
http://service.symantec.com and select your region under Global Service 
and Support.

Service and support offices
North America

Symantec Corporation
555 International Way
Springfield, OR 97477
U.S.A.

http://www.symantec.com/

Australia and New Zealand

Symantec Australia
Level 2, 1 Julius Avenue
North Ryde, NSW 2113
Sydney
Australia

http://www.symantec.com/region/reg_ap/
+61 (2) 8879-1000
Fax: +61 (2) 8879-1001

Europe, Middle East, and Africa

Symantec Customer Service Center
P.O. Box 5689
Dublin 15
Ireland

http://www.symantec.com/region/reg_eu/
+353 (1) 811 8032
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Every effort has been made to ensure the accuracy of this information. 
However, the information contained herein is subject to change without 
notice. Symantec Corporation reserves the right for such change without 
prior notice.

July 25, 2002

Latin America

Symantec Brasil
Market Place Tower
Av. Dr. Chucri Zaidan, 920
12° andar
São Paulo - SP
CEP: 04583-904
Brasil, SA

Portuguese: 
http://www.service.symantec.com/br
Spanish:
http://www.service.symantec.com/mx
Brazil: +55 (11) 5189-6300
Mexico: +52 55 5322 3681 (Mexico DF)
01 800 711 8443 (Interior)
Argentina: +54 (11) 5382-3802
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Norton AntiVirus™ for Macintosh®

CD Replacement Form

FOR CD REPLACEMENT
Please send me:    ___ CD Replacement

Name ________________________________________________________________________________________________________________

Company Name _______________________________________________________________________________________________________

Street Address (No P.O. Boxes, Please)_____________________________________________________________________________________

City ______________________________________________________________________ State _______ Zip/Postal Code _________________

Country* _________________________________________________________Daytime Phone _______________________________________

Software Purchase Date _________________________________________________________________________________________________

*This offer limited to U.S., Canada, and Mexico. Outside North America, contact your local Symantec office or distributor.

Briefly describe the problem:_____________________________________________________________________________________________

FORM OF PAYMENT ** (CHECK ONE):
___  Check (Payable to Symantec)  Amount Enclosed  $ _________ __ Visa       __ Mastercard      __  American Express

Credit Card Number ___________________________________________________________________________________Expires __________

Name on Card (please print) ________________________________________________ Signature ___________________________________

**U.S. Dollars. Payment must be made in U.S. dollars drawn on a U.S. bank.

MAIL YOUR CD REPLACEMENT ORDER TO:
Symantec Corporation

Attention:  Order Processing

555 International Way

Springfield, OR 97477 (800) 441-7234

Please allow 2-3 weeks for delivery within the U.S.

Symantec and Norton AntiVirus are trademarks of Symantec Corporation.
Other brands and products are trademarks of their respective holder/s.
 2003 Symantec Corporation. All rights reserved. Printed in the U.S.A.

CD REPLACEMENT: After your 60-Day Limited Warranty, if your CD becomes unusable, fill out and return 1) this form, 2) your
damaged CD, and 3) your payment (see pricing below, add sales tax if applicable), to the address below to receive replacement CD.
DURING THE 60-DAY LIMITED WARRANTY PERIOD, THIS SERVICE IS FREE.  You must be a registered customer in order to receive CD
replacements.
If your Symantec product was installed on your computer when you purchased it, contact your hardware manufacturer for CD 
replacement information.

CD Replacement Price   $ 10.00
Sales Tax (See Table) ______
Shipping & Handling $   9.95

TOTAL DUE ______

SALES TAX TABLE: AZ (5%), CA (7.25%), CO (3%), CT (6%), DC (5.75%), FL (6%), GA (4%), IA (5%), 
IL (6.25%), IN (5%), KS (4.9%), LA (4%), MA (5%), MD (5%), ME (6%), MI (6%), MN (6.5%), MO (4.225%),
NC (6%), NJ (6%), NY (4%), OH (5%), OK (4.5%), PA (6%), SC (5%), TN (6%), TX (6.25%), VA (4.5%), WA (6.5%), WI 
(5%).  Please add local sales tax (as well as state sales tax) in AZ, CA, FL, GA, MO, NY, OH, OK, SC, TN, TX, WA, WI. 
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prevention against new viruses 10
scheduling updates 41-43
using with America Online 45
What’s New file 40
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Mac OS System, on CD 11
macro viruses, spread in Microsoft Office 9
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Microsoft Office, data file virus protection 9
Minimal Protection level, Norton AntiVirus 13

N
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No Protection level, Norton AntiVirus 13
Norton AntiVirus

Compression Scanning options 13
contextual menu 24
email attachment scans 24
full protection 13
installing 10, 11
minimal protection 13
no protection 13
preferences, custom 20
protection after installation 12
protection levels 12, 13
scanning before installing 11
small scanner 24
standard protection 13
updating virus definitions 39
Virus Definitions Info 27

Norton AntiVirus Auto-Protect
about 19
activation 12
and Norton FileSaver 28
finding and repairing viruses 32
fine-tuning performance 28
responding to messages 31
turned on 10
turning off with Control Strip 20
Virus-like Activity alerts 34

Norton AntiVirus for Macintosh
looking up shortcuts 15
updating virus definitions 39

Norton FileSaver, and Norton AntiVirus 
Auto-Protect 28
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performance, adjusting in Norton FileSaver 28
preferences

Compression Scanning, Norton 
AntiVirus 13

general or custom 20
specifying Virus-like Activities 35
virus scanning, in Norton AntiVirus 12

problems after installing 12
program files, updating 37-39
protection

from viruses with Norton AntiVirus 10
updating virus definitions

in Norton AntiVirus 10
protection levels, in Norton AntiVirus 12
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Read Me file 11, 14

contents 11
opening on the CD 11
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responding to virus alerts 31
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if virus is found 32
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scheduling

program updates 41-43
scans 25

Service and Support 47
shortcuts for application 14
SimpleText application 11
small scanner, Norton AntiVirus 24
Standard Protection level, Norton AntiVirus 13
subscribing to virus definitions 13
Symantec AntiVirus for Macintosh
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incompatible with Norton AntiVirus virus 

definitions 11
Symantec Security Response 28
Symantec Web site 17
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late breaking news 16
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virus definitions 28

System folder, on CD 11
system requirements, in Read Me file 11
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with LiveUpdate 39

virus protection 37
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versions, checking with LiveUpdate 40
viewing, latest program updates 40

virus
alerts 31
avoiding with Norton AntiVirus 

protection 10
damage to files 33
definitions

described 9
looking up in Norton AntiVirus 9

definitions subscription 13
found while scanning 32
macro viruses 9
names 27
protection after installation 12
Repaired or Not Repaired status 33
repairing infected file 33
scanning preferences, in Norton 

AntiVirus 12
transferable from PC to Macintosh 9
updating protection 37
updating protection with Norton 

AntiVirus 10
viewing descriptions 28

virus definitions files
description 9
updating with LiveUpdate 39
updating with Norton AntiVirus 10

Virus Definitions Info dialog box, in Norton 
AntiVirus 27

virus definitions, updating with LiveUpdate 39
virus scan

deleting scheduled events 26
scheduling an event 25
scheduling automatic 25
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viruses
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